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Overview
Overview
The Cisco Video Surveillance Workstation Profiler Tool (Profiler Tool) is a stand-alone Windows utility 
that validates and predicts the ability of a PC client to render video. 

Workstation hardware and software strongly affects the ability of a workstation to play video. The 
Profiler Tool characterizes your workstation’s hardware and software capabilities and limitations, 
allowing you to make the workstation adjustments that are optimal for your operational environment.

The Profiler Tool provides a consistent means of measuring not only how well the workstation can 
display video in general, but also how well it performs under different conditions. 

When To Run The Test

To establish a baseline, you first run the Profiler Tool to take measurements right after the workstation 
is booted and no other applications have consumed system resources. Run the tool again during normal 
operation when other tools and applications are running. 

Examining the differences in performance between the baseline and normal measurements allows you 
decide how to configure your workstation to strike the best balance between video rendering 
performance and operational convenience. For example, you may learn that you can continue to run a 
particular application you need to use because it does not have a major on performance, or you may learn 
that you need to run the application on a different system because it does have a major impact.

Overall, the Profiler Tool help your stream profiles and workstations that best fit together. You can 
eliminate issues before they occur and help troubleshoot problems that do occur.

What the Profiler Tool Does and Does Not Do

The Profiler Tool is designed to perform specific tests. 

It DOES:

• Summarize the workstation hardware and software attributes.

• Tell the ability of the workstation to successfully display a variety of video clips from different 
codecs and multiple panes. 

• Identify issues or possible causes of concern that may affect the workstation’s ability to render 
video. 

It DOES NOT:

• Evaluate network throughput

• Validate video quality

See the “Caveats” section on page 17 for more information.
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System Requirements
System Requirements
You can download and run the Profiler Tool on any PC that meets the system requirements described in 
the Cisco Video Surveillance Monitoring Workstation Performance Baseline Specification.

After running initial baseline and operational tests, compare the results to determine whether you need 
to modify the workstation’s operational configuration to improve performance.

Restrictions for Laptops With i3 or i5 Processors

Computers with Intel i3 or i5 processors experience poor performance when running 5x5 video views, 
including high CPU usage and low frames per second. x5 layouts may be skipped when running the 
Profiler Tool on these computers. 
3
Using the Cisco Video Surveillance Monitoring Workstation Profiler Tool, Release 7

 

http://www.cisco.com/c/en/us/support/physical-security/video-surveillance-manager/products-technical-reference-list.html


 

Summary Steps
Summary Steps

Table 1 Summary Steps: Profiler Tool

Task Description

Step 1 Download and extract the Profiler 
Tool and sample video files. 

Note The sample video files are 
placed in the Profiles 
directory in the same 
location as the Profiler 
Tool.

See the “Installing the Profiler Tool and Sample Video Files” section on page 6. 

Step 2 Double click ProfilerTool.exe 
and choose Tools > Start Profiler 
to run a workstation test.

See the “Running a Profile Test” section on page 8.

See also the following:

• System Requirements, page 3

• Creating Baseline and Operational Profiles, page 16
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Summary Steps
Step 3 Wait for the test to complete and 
the ProfilerToolReport.txt to 
appear.

See the “Running a Profile Test” section on page 8 to understand how long the 
test can take. 

Step 4 Review the test report to identify 
system performance, system 
requirements and other possible 
issues that impact performance.

See the “Understanding the Test Results” section on page 11.

See also the following:

• Caveats, page 17

• Creating Baseline and Operational Profiles, page 16

• Sample Test Results, page 18

Table 1 Summary Steps: Profiler Tool (continued)

Task Description
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Installing the Profiler Tool and Sample Video Files
Installing the Profiler Tool and Sample Video Files
The Profiler Tool is distributed in a .ZIP archive file that contains the ProfilerTool.exe executable 
file. 

Usage Notes

The Profiler Tool tests the workstation capabilities by playing the video files that are added to the 
“Profiles” directory located in the same directory as the Profiler Tool

• The sample video files must downloaded and extracted to the “Profiles” directory (located in the 
same directory as the Profiler Tool), as shown in Figure 1. 

• Sample files are available in the H264, H264HD, JPEG, MPEG formats and include 1x1, 2x2, 3x3 
and 4x4 layouts. Download and extract the file formats required for testing by your deployment

• We recommend including all 4 layouts for complete workstation analysis.

• Any missing file formats or layouts are skipped and not included in the results. See the 
“Understanding the Test Results” section on page 11.

Figure 1 Sample Video Files in the “Profiles” Directory

Procedure

Step 1 Use a web browser to access the Cisco Video Surveillance Manager product page.

Step 2 Click Download Software.

Step 3 Select Video Surveillance Manager Stand-alone Tools.

Step 4 Select Release 7.0.1 (Figure 2).
6
Using the Cisco Video Surveillance Monitoring Workstation Profiler Tool, Release 7

 

http://www.cisco.com/c/en/us/support/physical-security/video-surveillance-manager/tsd-products-support-series-home.html
http://software.cisco.com/download/type.html?mdfid=282976740&i=rm


 

Installing the Profiler Tool and Sample Video Files
Figure 2 Profiler Tool Download Page

Step 5 Download the “Cisco Video Surveillance Workstation Profile Tool” and extract it to a local directory, 
such as \ProfilerTool.

Step 6 Download and extract the “Profile Tool Clips” to the same directory (Figure 3).
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Running a Profile Test
Figure 3 Profiler Tool Directory

Note Each of the “Profile” video sample codecs (H264, H264HD, JPEG, MPEG4) includes a set of 
video files in 1x1, 2x2, 3x3 and 4x4 layouts. These files are used by the Profiler Tool to analyze 
the ability of your workstation to process video. Include the codecs required by your 
deployment. Any missing files are skipped.

Running a Profile Test
There are two profile tests: a regular test that skips the remaining layouts for a codec if any layout tests 
fails, and the Stress test that tests all layouts for all codecs.

Procedure

Step 1 Determine if you want to test the workstation in baseline or operational mode. 

See the “Creating Baseline and Operational Profiles” section on page 16.

Step 2 Launch the ProfilerTool.exe from the directory where you extracted the tool and video profiles 
(Figure 3). 
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Running a Profile Test
Step 3 Click Tools and start the test as described in Table 2 (see also Figure 4):

Note Any missing file format or layout directory is skipped. For example, if the MPEG4 directory is missing, 
the test proceeds to H264 after completing JPEG. If the 2x2 layout in JPEG directory is missing, the test 
proceeds to the JPEG 3x3 layout after completing 1x1.

Table 2 Test Options in the “Tools” Menu

“Tools” Menu 
Option Test Type Description

Start Profiler Regular test Runs each of the video profiles in succession for 1 minute. 

• If a video clip fails the profile test, then all remaining clips for that codec are 
skipped. 

• For example, if the 1x1 H264HD video clip fails, then the Profiler Tool assumes 
the other H264HD layouts (2x2, 3x3, and 4x4) will also fail since the additional 
layouts for that codec will require even more processing power.

Note A failed test occurs when CPU usage is over 90% or frames-per-second (fps) 
is 20% below the target frame rate. For example, a fps 30 video clip has a pass 
threshold of 24 fps. See the “Understanding the Test Results” section on 
page 11.

Start Stress Test Stress test All video profiles included in the Profiles folder are run even if one or more clips 
fails.

For example, if the 1x1 H264HD video clip fails, the Profiler Tool still tests the 
remaining H264HD layouts (2x2, 3x3, and 4x4), allowing you to view the results for 
each test.

Stop Profiler Stop the test Stop a running profile test. Incomplete results will be displayed in the 
ProfilerToolReport.txt report. 
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Running a Profile Test
Figure 4 Profile Test Options

Step 4 Wait for all tests to complete. 

• The test for each layout takes 1 minute to complete.

• Each codec (JPEG, MPEG4, H264, H264HD) includes video clips for four layouts: 1x1, 2x2, 3x3, 
and 4x4. It takes 16 minutes for all tests to run. Less time is required if a tests fails using the regular 
test (since additional layouts for that codec are skipped) or if you choose Stop Profiler before 
testing is complete.

Step 5 Continue to “Understanding the Test Results”.
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Understanding the Test Results
Understanding the Test Results
The test results are displayed in the ProfilerToolReport.txt file that is automatically created at the 
end of the test. The report includes three major sections:

Tip The ProfilerToolReport.txt report is automatically created and saved to the Profiler Tool directory. 
Choose File > Save As to save the file to another name to compare against additional tests.

The Profiler Tool measures successful playback for a given video pane using the following criteria:

• The pane can successfully access the video file

• The pane can successfully play the video file

• The pane can successfully render at least 80% of the nominal video frame rate

• CPU usage is under 90%

Additional criterion for layout success:

• All videos in a layout are rendered successfully

Note • If a layout fails, all subsequent layouts for that profile are skipped unless you selected the Stress 
Test.

• Any missing or mis-named directories or sample video files are skipped and not included in the 
results. See the “Installing the Profiler Tool and Sample Video Files” section on page 6 for more 
information.

Tip See the “Caveats” section on page 17 for more information.

Table 3 Sections in the ProfilerToolReport.txt File

Report Section Description More Information

System Profile A system profile that lists the major hardware and software 
characteristics of the workstation.

System Profile, page 12

Test Details By Profile The frames-per-second (fps) and CPU usage for each valid codec 
and layout included in the “Profiles” directory.

Test Details By Profile, 
page 13

Issues How You Know that Your Tests Succeeded Issues, page 16
11
Using the Cisco Video Surveillance Monitoring Workstation Profiler Tool, Release 7

 



 

Understanding the Test Results
Figure 5 Profiler ToolReport 

System Profile
Review the system profile at the top of the ProfilerToolReport.txt output to verify that the 
workstation meets the basic system requirements. Compare the system profile with the requirements 
described in the Cisco Video Surveillance Monitoring Workstation Performance Baseline Specification.

The following example shows the system profile included at the top of the ProfilerToolReport.txt 
output:

Cisco PSBU Profiler Tool version: 7.0.110.48315
AXClient Version: 7.0.110.48308
User Account Type:  Administrator 
Windows Version: Windows 7 64-bit Service Pack 2
.Net Framework: .NET Framework 4.0 Full installed
DirectX Version: DirectX 11.0 installed
Internet Explorer Version: 9.0.8112.16421
Desktop Composition State: Desktop composition is enabled
Graphics Card Model & Specs:

Model: Intel(R) HD Graphics Family
Driver Version: 8.15.10.2321
Driver Date: 03/06/2011
Bit Depth: 32
Total Adapter RAM: 1,797 MB
Model: NVIDIA Quadro 1000M 
Driver Version: 8.17.12.6696
Driver Date: 02/02/2011
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Understanding the Test Results
Bit Depth: 5168428
Total Adapter RAM: 2,048 MB
Display 1 resolution: 1920 x 1080

Network Adapters:
Device Name: Intel(R) 82579LM Gigabit Network Connection
Driver Version: 11.8.84.0
Driver Date: 12/21/2010
Device Name: Intel(R) Centrino(R) Ultimate-N 6300 AGN
Driver Version: 13.4.0.9
Driver Date: 10/18/2010

CPU Specification:
Number of CPUs = 8
Intel64 Family 6 Model 42 Stepping 7
Intel(R) Core(TM) i7-2760QM CPU @ 2.40GHz
Speed = 2392

Total Physical Memory: 3,979 MB

Review this information to verify that the workstation supports the specification in the Cisco Video 
Surveillance Monitoring Workstation Performance Baseline Specification.

Test Details By Profile
The test results are shown for each “Profile Name”, which is the video file being tested.

Note • If a layout fails, all subsequent layouts for that profile are skipped unless you selected the Stress 
Test.

• Any missing or mis-named directories or sample video files are skipped and not included in the 
results. See the “Installing the Profiler Tool and Sample Video Files” section on page 6 for more 
information.

The following example shows the test results for the JPEG_SD_30fps_1x1.cva standard-definition JPEG 
video file that should play at 30 frame per second in a 1x1 layout (meaning there is only a single pane 
of video). These results show the fps that actually played for this video layout, the percentage of CPU 
processing capacity consumed during the playback, and the amount of memory used during the 
playback.

Profile Name: JPEG_SD_30fps_1x1.cva
Codec Type: JPEG
Layout Type: 1x1
Number Of Panes: 1

pane 0: 29.99 fps
CPU (avg, max): 3.11%  4.68%
Maximum Memory Used: 126556 KB

The following table describes each field in the profile results.

Table 4 Test Result Details

Field Description

Profile Name The file name of the video file being tested. 

Codec Type The video codec: JPEG, MPEG4, H264, or H264HD
13
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Understanding the Test Results
Layout Type The display layout.: 1x1, 2x2, 3x3 or 4x4. 

A test is run for each layout included for the codec.

Number Of Panes The number of video panes included in the layout. 

For example, a 1x1 layout includes a single video pane. A 4x4 layout included 16 video panes.

pane x The frames-per-second (fps) that actually played for each video pane in the layout. 

The following successful test shows a 2x2 layout with 4 video panes:

Number Of Panes: 4
pane 0: 29.98 fps
pane 1: 29.99 fps
pane 2: 29.99 fps
pane 3: 29.99 fps

The pane must successfully render at least 80% of the nominal video frame rate for the test to pass. If 
the test fails, the remaining layouts for the codec are skipped, unless you choose the Stress Test option 
(see the “Running a Profile Test” section on page 8 for more information).

In the following example, the test fails because the frame rate for one or more panes is below 80% of 
the nominal 30 fps for the clip.

Profile Name: H264_HD_30fps_3x3.cva
Codec Type: H264HD
Layout Type: 3x3
Number Of Panes: 9

pane 0: 18.94 fps
pane 1: 15.06 fps
pane 2: 20.38 fps
pane 3: 13.46 fps
pane 4: 20.11 fps
pane 5: 21.40 fps
pane 6: 20.05 fps
pane 7: 22.04 fps
pane 8: 12.45 fps

CPU (avg, max): 38.78%  85.18%
Maximum Memory Used: 658116 KB

Table 4 Test Result Details (continued)

Field Description
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Understanding the Test Results
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pane x The frames-per-second (fps) that actually played for each video pane in the layout. 

The following successful test shows a 2x2 layout with 4 video panes:

Number Of Panes: 4
pane 0: 29.98 fps
pane 1: 29.99 fps
pane 2: 29.99 fps
pane 3: 29.99 fps

The pane must successfully render at least 80% of the nominal video frame rate for the test to pass. If 
the test fails, the remaining layouts for the codec are skipped, unless you choose the Stress Test option 
(see the “Running a Profile Test” section on page 8 for more information).

In the following example, the test fails because the frame rate for one or more panes is below 80% of 
the nominal 30 fps for the clip.

Profile Name: H264_HD_30fps_3x3.cva
Codec Type: H264HD
Layout Type: 3x3
Number Of Panes: 9

pane 0: 18.94 fps
pane 1: 15.06 fps
pane 2: 20.38 fps
pane 3: 13.46 fps
pane 4: 20.11 fps
pane 5: 21.40 fps
pane 6: 20.05 fps
pane 7: 22.04 fps
pane 8: 12.45 fps

CPU (avg, max): 38.78%  85.18%
Maximum Memory Used: 658116 KB

ble 4 Test Result Details (continued)

ield Description
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Creating Baseline and Operational Profiles
Issues
The ISSUES section at the end of the report displays issues that should be addressed to improve 
performance. For example:

ISSUES:
Graphics card driver for Intel(R) HD Graphics Family is 745 days old
Graphics card driver for NVIDIA Quadro 1000M  is 777 days old
Network adapter driver for Intel(R) 82579LM Gigabit Network Connection is 820 days old
Network adapter driver for Intel(R) Centrino(R) Ultimate-N 6300 AGN is 884 days old
AXClient not installed

Issues include possible items flagged by the system that may or may not impact system performance and 
test results.

For example:

• The graphics card or network card driver is out of date:

– 6 months = marginally out of date

– 1 year = significantly out of date

– 2+ years = extremely out of date

• The Internet Explorer web browser is the wrong version.

• The ActiveX Client is not installed.

See the “System Requirements” section on page 3 for more information.

Creating Baseline and Operational Profiles
We strongly recommend that you take a baseline profile of your system to determine an upper bound on 
the ability of your workstation to play video. The baseline profile is taken with all applications and 
services that are not essential to run your system turned off, and then saved for later reference.

You can then turn on the applications and services again and run profiles again. If the measurements you 
get are significantly lower than the baseline, you can turn non-critical applications and services off 
selectively until you are able to achieve acceptable measurements.

In particular, note that following applications and services may have a significant impact on 
performance:

• Backup, restoring, and archiving processes

• Anti-virus software

• Any other software that requires significant processor resources

Note Firewalls do not affect performance and do not need to be turned off for the baseline measurements.

Maximum Memory 
Used

The maximum amount of memory used during the text of the video file (in KB).

Table 4 Test Result Details (continued)

Field Description
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Caveats
Procedure

To create a baseline or operational profile, follow these steps:

Step 1 Gather any sample profile clips that you want to use as part of the baseline profile.

Step 2 Log into your workstation as administrator.

Step 3 Turn off applications and services:

– If you are running a baseline profile, turn off all applications and services that are not essential 
to running your workstation, and reboot your system.

– If you are running an operational profile, turn off all the applications that are not needed for 
normal operation, and reboot your system.

Step 4 Extract all the contents of the Profiler Tool .ZIP archive (see the “Installing the Profiler Tool and Sample 
Video Files” section on page 6).

Step 5 Complete the profile test as described in the “Running a Profile Test” section on page 8.

Step 6 Interpret the test results as described in the “Understanding the Test Results” section on page 11.

Step 7 (Optional) Click Save As and save the results to a text file.

Step 8 (Optional) Revise the workstation hardware or software attributes to align with the requirements defined 
in the Cisco Video Surveillance Monitoring Workstation Performance Baseline Specification.

Step 9 (Optional) Repeat this procedures to compare the results with the previous test.

Caveats
Many factors combine in complex ways to produce the quality of experience for displayed video. 
Because the Profiler Tool is a stand-alone utility that uses local clip files, it cannot guarantee that video 
streams over the network will play properly. It cannot determine the visual quality of video; therefore, 
it displays video for you to examine visually while the test are running.

The following specific factors are outside the measurement and prediction scope of the Profiler Tool. 

• Cannot alter the CPU usage on your workstation. To improve performance, you must make hardware 
or software adjustments based on the baseline and operational test results. 

• Cannot validate video quality.

• Does not determine the smoothness of play back.

• Does not report number of dropped frames.

• Cannot evaluate network throughput.

• Only .CVA video files are supported. The Profiler Tool does not test video from other formats. 

• Can estimate, but not calculate precisely, the overall performance within a Operations Manager 
interface running in a browser.

• Cannot predict interactions with applications that are not part of the test.

• Can save test result details only for the currently completed test.
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Sample Test Results
Sample Test Results
The following sample test results include a summary of the test results, workstation details, possible 
issues that may affect video performance, and detailed test results. See the “Understanding the Test 
Results” section on page 11 for more information.

Cisco PSBU Profiler Tool version: 7.0.110.48315
AXClient Version: AXClient not installed
User Account Type:  Administrator 
Windows Version: Windows 7 64-bit Service Pack 1
.Net Framework: .NET Framework 4.0 Full installed
DirectX Version: DirectX 11.0 installed
Internet Explorer Version: 9.0.8112.16421
Desktop Composition State: Desktop composition is enabled
Graphics Card Model & Specs:

Model: Intel(R) HD Graphics Family
Driver Version: 8.15.10.2321
Driver Date: 03/06/2011
Bit Depth: 32
Total Adapter RAM: 1,797 MB
Model: NVIDIA Quadro 1000M 
Driver Version: 8.17.12.6696
Driver Date: 02/02/2011
Bit Depth: 5863948
Total Adapter RAM: 2,048 MB
Display 1 resolution: 1920 x 1080

Network Adapters:
Device Name: Intel(R) 82579LM Gigabit Network Connection
Driver Version: 11.8.84.0
Driver Date: 12/21/2010
Device Name: Intel(R) Centrino(R) Ultimate-N 6300 AGN
Driver Version: 13.4.0.9
Driver Date: 10/18/2010

CPU Specification:
Number of CPUs = 8
Intel64 Family 6 Model 42 Stepping 7
Intel(R) Core(TM) i7-2760QM CPU @ 2.40GHz
Speed = 2392

Total Physical Memory: 3,979 MB

TEST DETAILS BY PROFILE:
Profile Name: JPEG_SD_30fps_1x1.cva
Codec Type: JPEG
Layout Type: 1x1
Number Of Panes: 1

pane 0: 29.99 fps
CPU (avg, max): 3.11%  4.68%
Maximum Memory Used: 126556 KB

Profile Name: JPEG_SD_30fps_2x2.cva
Codec Type: JPEG
Layout Type: 2x2
Number Of Panes: 4

pane 0: 29.98 fps
pane 1: 29.99 fps
pane 2: 29.99 fps
pane 3: 29.99 fps

CPU (avg, max): 5.68%  7.84%
Maximum Memory Used: 188724 KB

Profile Name: JPEG_SD_30fps_3x3.cva
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Codec Type: JPEG
Layout Type: 3x3
Number Of Panes: 9

pane 0: 29.99 fps
pane 1: 29.97 fps
pane 2: 29.99 fps
pane 3: 29.99 fps
pane 4: 29.97 fps
pane 5: 29.99 fps
pane 6: 29.99 fps
pane 7: 29.99 fps
pane 8: 29.97 fps

CPU (avg, max): 16.16%  20.58%
Maximum Memory Used: 301600 KB

Profile Name: JPEG_SD_30fps_4x4.cva
Codec Type: JPEG
Layout Type: 4x4
Number Of Panes: 16

pane 0: 29.98 fps
pane 1: 29.98 fps
pane 2: 29.98 fps
pane 3: 29.98 fps
pane 4: 29.97 fps
pane 5: 29.98 fps
pane 6: 29.97 fps
pane 7: 29.97 fps
pane 8: 29.98 fps
pane 9: 29.98 fps
pane 10: 29.97 fps
pane 11: 29.98 fps
pane 12: 29.97 fps
pane 13: 29.98 fps
pane 14: 29.97 fps
pane 15: 29.98 fps

CPU (avg, max): 29.46%  40.88%
Maximum Memory Used: 461288 KB

Profile Name: MPEG4_SD_30fps_1x1.cva
Codec Type: MPEG4
Layout Type: 1x1
Number Of Panes: 1

pane 0: 29.43 fps
CPU (avg, max): 5.09%  6.09%
Maximum Memory Used: 155900 KB

Profile Name: MPEG4_SD_30fps_2x2.cva
Codec Type: MPEG4
Layout Type: 2x2
Number Of Panes: 4

pane 0: 29.42 fps
pane 1: 29.42 fps
pane 2: 29.42 fps
pane 3: 29.42 fps

CPU (avg, max): 10.00%  11.78%
Maximum Memory Used: 243972 KB

Profile Name: MPEG4_SD_30fps_3x3.cva
Codec Type: MPEG4
Layout Type: 3x3
Number Of Panes: 9

pane 0: 29.37 fps
pane 1: 29.37 fps
pane 2: 29.37 fps
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Sample Test Results
pane 3: 29.37 fps
pane 4: 29.37 fps
pane 5: 29.37 fps
pane 6: 29.37 fps
pane 7: 29.37 fps
pane 8: 29.37 fps

CPU (avg, max): 27.31%  35.22%
Maximum Memory Used: 387676 KB

Profile Name: MPEG4_SD_30fps_4x4.cva
Codec Type: MPEG4
Layout Type: 4x4
Number Of Panes: 16

pane 0: 23.80 fps
pane 1: 23.82 fps
pane 2: 23.81 fps
pane 3: 23.82 fps
pane 4: 23.81 fps
pane 5: 23.83 fps
pane 6: 23.83 fps
pane 7: 23.81 fps
pane 8: 23.82 fps
pane 9: 23.82 fps
pane 10: 23.82 fps
pane 11: 23.81 fps
pane 12: 23.83 fps
pane 13: 23.84 fps
pane 14: 23.83 fps
pane 15: 23.81 fps

CPU (avg, max): 22.14%  64.67%
Maximum Memory Used: 468300 KB

Profile Name: H264_SD_30fps_1x1.cva
Codec Type: H264
Layout Type: 1x1
Number Of Panes: 1

pane 0: 29.39 fps
CPU (avg, max): 3.49%  4.19%
Maximum Memory Used: 170336 KB

Profile Name: H264_SD_30fps_2x2.cva
Codec Type: H264
Layout Type: 2x2
Number Of Panes: 4

pane 0: 29.39 fps
pane 1: 29.39 fps
pane 2: 29.39 fps
pane 3: 29.39 fps

CPU (avg, max): 5.32%  6.60%
Maximum Memory Used: 254080 KB

Profile Name: H264_SD_30fps_3x3.cva
Codec Type: H264
Layout Type: 3x3
Number Of Panes: 9

pane 0: 29.35 fps
pane 1: 29.36 fps
pane 2: 29.36 fps
pane 3: 29.37 fps
pane 4: 29.36 fps
pane 5: 29.37 fps
pane 6: 29.36 fps
pane 7: 29.37 fps
pane 8: 29.37 fps
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Sample Test Results
CPU (avg, max): 12.21%  16.18%
Maximum Memory Used: 393984 KB

Profile Name: H264_SD_30fps_4x4.cva
Codec Type: H264
Layout Type: 4x4
Number Of Panes: 16

pane 0: 29.24 fps
pane 1: 29.31 fps
pane 2: 29.33 fps
pane 3: 29.33 fps
pane 4: 29.33 fps
pane 5: 29.31 fps
pane 6: 29.33 fps
pane 7: 29.33 fps
pane 8: 29.31 fps
pane 9: 29.33 fps
pane 10: 29.33 fps
pane 11: 29.33 fps
pane 12: 29.31 fps
pane 13: 29.33 fps
pane 14: 29.24 fps
pane 15: 29.31 fps

CPU (avg, max): 29.97%  39.74%
Maximum Memory Used: 587036 KB

Profile Name: H264_HD_30fps_1x1.cva
Codec Type: H264HD
Layout Type: 1x1
Number Of Panes: 1

pane 0: 29.40 fps
CPU (avg, max): 4.89%  5.91%
Maximum Memory Used: 210304 KB

Profile Name: H264_HD_30fps_2x2.cva
Codec Type: H264HD
Layout Type: 2x2
Number Of Panes: 4

pane 0: 29.15 fps
pane 1: 29.15 fps
pane 2: 29.15 fps
pane 3: 29.15 fps

CPU (avg, max): 33.02%  39.35%
Maximum Memory Used: 390524 KB

Profile Name: H264_HD_30fps_3x3.cva
Codec Type: H264HD
Layout Type: 3x3
Number Of Panes: 9

pane 0: 18.94 fps
pane 1: 15.06 fps
pane 2: 20.38 fps
pane 3: 13.46 fps
pane 4: 20.11 fps
pane 5: 21.40 fps
pane 6: 20.05 fps
pane 7: 22.04 fps
pane 8: 12.45 fps

CPU (avg, max): 38.78%  85.18%
Maximum Memory Used: 658116 KB

ISSUES:
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Related Documentation
Graphics card driver for Intel(R) HD Graphics Family is 745 days old
Graphics card driver for NVIDIA Quadro 1000M  is 777 days old
Network adapter driver for Intel(R) 82579LM Gigabit Network Connection is 820 days old
Network adapter driver for Intel(R) Centrino(R) Ultimate-N 6300 AGN is 884 days old
AXClient not installed

Related Documentation
• Cisco Video Surveillance Monitoring Workstation Performance Baseline Specification

• See the Cisco Video Surveillance 7 Documentation Roadmap for descriptions and links to Cisco 
Video Surveillance documentation, server and storage platform documentation, and other related 
documentation.
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